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LANGUAGE DECLARATION OF CONFORMITY
Spanish Mediante el presente documento, Benefon declara que este teléfono móvil, del tipo TGP79EE, satisface los requisitos 

esenciales y todas las demás disposiciones pertinentes de la Directiva 1999/5/EC.

Danish Benefon Oyj erklærer herved, at denne mobiltelefon af typen TGP79EE er i overensstemmelse med de væsentlige krav 

og andre relevante betemmelser i Directive 1999/5/EC.

German Hiermit erklärt Benefon Oyj, daß dieses Mobiltelefon vom Typ TGP79EE die wesentlichen Anforderungen und andere 

relevante Bestimmungen der Richtlinie 1999/5/EC erfüllt.

Greek Με το παρόν, η Benefon Oyj δηλώνει ότι αυτό το κινητό τηλέφωνο, τύπου TGP79EE, συµµορφώνεται µε τις ουσιώδεις 
απαιτήσεις και άλλους σχετικούς όρους της Οδηγίας 1999/5/EC.

English Hereby, Benefon Oyj declares that this mobile phone, type TGP79EE, is in compliance with the essential 

requirements and other relevant provisions of Directive 1999/5/EC.

French Benefon Oyj déclare par les présentes que ce téléphone mobile, de type TGP79EE, est conforme aux exigences 

essentielles et aux dispositions correspondantes de la Directive européenne 1999/5/EC.

Italian Benefon Oyj dichiara che questo modello di telefono cellulare, tipo TGP79EE, risponde alle principali specifiche e 

misure previste dalla Direttiva 1999/5/EC.

Dutch Bij deze verklaart Benefon Oyj dat deze mobiele telefoon, type TGP79EE, voldoet aan de voornaamste eisen en 

andere relevante voorwaarden van Richtlijn 1999/5/EC.

Portuguese A Benefon Oyj declara pela presente que este telemóvel, do tipo TGP79EE, está em conformidade com os requisitos 

essenciais e outras disposições relevantes da Directiva 1999/5/EC.

Finnish Benefon Oyj vakuuttaa, että tämä matkapuhelin, tyyppiä TGP79EE, on direktiivin 1999/5/EC olennaisten vaatimusten 

ja muiden asianomaisten määräysten mukainen

Swedish Härmed förklarar Benefon Oyj att denna mobiltelefon, typ TGP79EE, överenstämmer med de grundläggande kraven 

och andra relevanta bestämmelser i Direktiv 1999/5/EC.

Information in this manual is subject to change without notice. 
BENEFON reserves the right to change or improve their products and to
make changes in the content without obligation to notify any person or
organization of such changes or improvements. 
BENEFON is not responsible for any loss of data, income or any
consequential damage whatsoever caused.   

Manufacturer: Benefon Oyj, P.O. Box 84, 

24101 Salo, Finland 

Web site: www.benefon.com
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PART A: GENERALBENEFON SERAPH OPERATING INSTRUCTIONS
PART A: GENERAL

MECHANICS AND ENVIRONMENTAL 
EFFECTS

Sight
The device must have an unobstructed view to satellites at

any time. 

The device can be used like a standard GSM phone. In some

cases, the device can be built in clothes or special vests.

If the device is mounted somehow, it must be attached to

the surface so that the back of the device is facing up. To en-

sure proper functioning of the GPS, the GPS antenna can be

covered with plastic, fiber glass or clothes, but not with met-

al. 

In marginal conditions an external GPS antenna, possibly

even a GSM antenna, must be installed. 

Temperature ranges
•Usage: -20 to +55 °C  with a standard Li-Ion battery 

•Charging: Standard Li-Ion battery must not be charged

below °0. Likewise, charging above +55 °C is prevented. 

At temperatures below -25 °C, or above +60 °C, the battery

will not supply power and the device cannot be used. 

Upon warming up/cooling down, the device will function

properly again.  

Mechanical durability 
The device is dust and splash proof. The protection category

for the device is IPX4. 

To meet these requirements, the rubber seal must be insert-

ed in place correctly. 
MECHANICS AND ENVIRONMENTAL EFFECTS 7



PART B: CONFIGURING SETTINGS FOR THE SERAPH
PART B: CONFIGURING 
SETTINGS FOR THE SERAPH

There are two ways to configure settings for the device: 

•You can use MPTP (Mobile Phone Telematics Protocol)

commands and transfer settings remotely, over the air by

sending a protocol message to the device. 

•You can use the Benewin software for configuring settings

and transfer them to the device locally, via the data cable.   

MPTP MESSAGES AND 
REMOTE CONFIGURATION (OTA)

MPTP configuration commands are used when a remote up-

date of device configuration is needed. Update can include

all telematics settings and phone numbers, such as emer-

gency numbers, GPS operating mode, call options. Some

functions, such as tracking and area tracking, are available

only via MPTP. For more information on supported telemat-

ics features offered by MPTP, see the separate MPTP list in

Appendix of this manual.  

Remote configuration can be used for transferring settings

only in case the settings are coded as MPTP messages. 

For more information on MPTP messages, please see the

separate document on MPTP commands, located at the Web

site: www.benefon.com. 

CAP RUBBER TAB

BOTTOM COVER

1. Place the rubber seal so
that it lies at the bottom of
the battery hole (1). 

2. Fit the rubber tab into the
recess in the upper left
corner (2). 

3. Lift the cap on the top of
the rubber tab (3).

4. Fit the battery in place. 

5. Push the battery into the
device until it locks in pla-
ce, and make sure the re-
lease catch has clicked
into place. 

6. The idea is that the batte-
ry will be securely faste-
ned in the battery hole.   

7. When the cable/charger
connection is not needed,
stuff the bottom cover into
the system connector so
that the cover will be firm-
ly secured around the
connector (4).  

REMOVING THE BATTERY:
Push the release catch down-
wards and pull the battery ca-
refully away from the device.

SYSTEM CONNECTOR

INSERTING THE BATTERY AND RUBBER SEAL

RELEASE CATCH

12
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PART B: CONFIGURING SETTINGS FOR THE SERAPH
THE BENEWIN SOFTWARE FOR THE 
SERAPH  

The Benewin software is intended for editing  settings local-

ly for the Seraph. Since the Benewin is very easy to use, it is

advisable to make initial and other major configurations for

the device with this software.  

When you are finished with editing, you can either transfer

the settings back to the device immediately, or save them in

a computer disk (as any normal file) for further use. 

The settings done within the software can be transferred to

the device via the Data cable or NMEA 0183 cable (in the lat-

ter case, use the Data adapter for the connection. NOTE:

Seraph does not support NMEA output and it cannot turn on

in  the Benewin). 

Another, slightly quicker way to transfer configurations

made by Benewin is to use the some other application, e.g.

the SetupLoad software. For more information on it, please

contact your dealer. 

The Benewin application window is split in two sections: 

•The Benetree structure is located on the left. It consists of

two main nodes: My benefon (on-line) and My computer

(off-line).  By clicking the main nodes, you have access to

their sub-nodes. By clicking the sub-nodes, you have

access to the corresponding Benewin document files.  

•The Document window is located on the right. The set-

ting groups are divided up into interleaves containing

separate data fields.   

Connecting the Seraph 
to the Benewin software   

1. Plug the square-end of the Data cable into a serial port

of your computer. The NMEA 0183 cable contains two

square-end adapters. In case you use the NMEA 0183 ca-

ble, plug the data adapter (1) into a serial port. Serial

ports are located at the back panel of your computer. 

Next plug the small end (2) of the cable into the system

connector on the bottom of the device. 

   

2. Open the Benewin. 

3. Choose the correct serial port from the toolbar:  Click

the pop-up menu and highlight the desired port.

1

2
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PART B: CONFIGURING SETTINGS FOR THE SERAPH
  

Or, choose Benewin Pro... from the Edit menu. Select the

Default communication port by clicking the box. Click OK
to exit the menu. 

     

4. Double-click the main node My Benefon. Or, double-

click the Seraph icon. Or, choose Connect from the Mo-
bile menu. Or, click the button Connect located on the

toolbar. 

  

5. The software establishes a connection to the device and

renames My Benefon node according to the type of the

device, in this case Seraph.

6. At the same time the software reads data from the device

and loads it in the display. The data contains currently

existing settings and menus from the device. In the 

Benetree these settings and menus are shown as sub-

nodes, such as Seraph settings under the main node My
Benefon. 

7. If the software requests security code while loading the

settings, you must key in the code and press Ok. For

more information on security code, see SECURITY CODE

ON PAGE 30.  

8. Click the name label Seraph. The sub-nodes will be dis-

played as icons in the Document window on the right. 

9. You can choose the desired sub-node/icon by clicking it.

The data fields will be displayed. 

Loading settings from the Seraph
to the software

As you connect the device to the software, all current set-

tings found in the device are copied to the software. 

To load only part of the settings to the software, choose Be-
newin Pro...  from the Edit menu. Check the desired setting

groups, which are located in the Mobile phone start up tasks.

Click Ok while the dialog box is displayed. 

Unloaded settings can be loaded later on in the same session

by choosing Open NNsettings from the Mobile menu.  

 

THE MAIN IDEA IS THAT THE PORT SELECTED IN SOFTWARE

MATCHES WITH THE PORT THE DATA ADAPTER IS PLUGGED IN.
10 THE BENEWIN SOFTWARE FOR THE SERAPH



PART B: CONFIGURING SETTINGS FOR THE SERAPH
Saving settings in a computer disk
1. If the device is not currently connected to the software,

you can still make configurations, save them and trans-

fer them to the device afterwards.  When working this

way, data fields are available for editing via  My computer
node.    

2. To save data in a computer disk, choose Save as... from

the File menu. You can also click the function icon on

the toolbar.

 

3. Select the destination drive and folder, and rename the

file the way you like. Click Save. The software stores all

data fields that the chosen sub-node (e.g. Seraph set-
tings) contains.   

Transferring settings from the
software to the Seraph

While the Benewin software is connected to the device, you

can save data in the device.  

1. First open the Benewin document which content you

want to save in the device. 

Settings which are previously stored in a computer disk

can be recalled by choosing Open from the File menu, 

or pressing the corresponding function icon on the tool-

bar.   

2. Choose Save To Mobile from the File menu. 

Or, click the function icon on the toolbar.  

When transferring data to the device, the previous data

is replaced with the new data.   
THE BENEWIN SOFTWARE FOR THE SERAPH 11



PART B: CONFIGURING SETTINGS FOR THE SERAPH
Changing default mobile phone
When any Benefon phone or device is connected to the Be-

newin, the software identifies it automatically, and offers

you the correct data fields for editing.  

To make off-line configuration for some other Benefon

phone (e.g. Esc!) when the phone is unavailable, you need

to change the default mobile phone in Benewin. 

1. Change the default Benefon mobile phone by selecting

Benewin Pro... from the Edit menu, or highlighting the

desired phone model from the pop-up menu, located

on the toolbar.

2. As the correct phone is selected, the data fields of this

phone model are available and can be opened from the

My computer node, by double-clicking the desired sub-

node.  

Resetting 
You can reset major part of the settings made in Benewin by

selecting Reset Seraph settings from the Mobile menu.  

By using this option, most of the emergency and telematics

settings, such as Emergency numbers, Authorised numbers,

will be reset at once. 

To view the reset settings in detail, you need to save them

to the device and load them from the device once again. 

Disconnecting the Seraph 
from the software   

1. Choose Disconnect from the Mobile menu. 

Or, click the button Disconnect on the toolbar.

     

2. To unplug the device from the cable, press and hold

down the release button (3) on the top of the small end

of the cable. 

Gently pull the cable from the system connector of the

device.

 

3
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PART B: CONFIGURING SETTINGS FOR THE SERAPH
SIM FEATURES: SHORT MESSAGES
In order to write or send normal short messages via device,

the device must be connected to an external device. Receiv-

ing short messages via device is not possible.   

The external device attached to the device can be e.g. a com-

puter, a laptop or a palm computer. Since the device lacks

the full-size keyboard and text screen, the external device

must be provided with these. The physical connection is es-

tablished with the data cable. 

A suitable software, for example the Benewin software, is

needed for the communication as well.

Reading and editing existing 
messages

You can read and edit messages you have written and saved

as .sms files in the computer. 

To open messages stored in the computer, select Open from

the File menu. Make sure the Files of type shows Short mes-
sages (or All Benewin Pro Files). Find the desired file by

browsing and click Open. 

Messages are listed and can be read. 

Editing: Double-click the message you want to edit. Edit text

and other details and click Ok when ready.  

Writing and sending a short message  
1. Open the Benewin software.  

2. Double-click the icons SIM, Short messages and Own
messages.  

3. Choose Sms, New message from the Edit menu.

4. Key in the message text and the recipient´s number. By

clicking the square beside the topic, the number can be

fetched from the Phone book, assuming the number is

found.   

5. Make sure, the Sms service number is correct. It can be

changed by clicking the square beside. By selecting the

option SIM card default, the SMS service number will be

picked up from the SIM card. If the SIM card does not

contain the SMS number, select the option Own and key

in the SMS number. 

6. Select the desired Saving/Sending action by checking the

box. 

7. Complete by pressing Ok. 

NOTE: When the device is disconnected, you can still write

short messages and save them for further use, but sending

the message is possible only while the device is connected

to the software. To work in off-line, you need to select Short
messages from My computer node. 
SIM FEATURES: SHORT MESSAGES 13



PART B: CONFIGURING SETTINGS FOR THE SERAPH
SIM FEATURES: PHONE BOOK
As you open the Phone book, the memory entries stored in

the SIM card are listed and can be processed. Index number

stands for memory slot number.  

NOTE: Benewin displays the names in the data fields only in

case the names are stored in the phone book on SIM card.  

Editing and adding an entry
1. To edit details of an entry, highlight the desired entry.

To add a new phone book entry, click a blank line.

2. Key in name and number in the lower part of the Docu-

ment window. 

3. By pressing Tab on the keyboard, you can move from a

data field to another.

4. Press Enter on the keyboard to confirm changes.

Deleting entries  
1. To delete a phone book entry, click the desired entry. 

2. Press Delete on the keyboard. You can also choose the

command Delete from the Edit  menu, or by clicking the

mouse´s right button. 

Moving and copying entries   
1. To move or copy a phone book entry to another slot,

click the desired entry. 

2. Press Ctrl+C (for copy) or Ctrl+X (for cut) on the key-

board. Click the destination line and press Ctrl+V (for

paste) on the keyboard. 

You can also choose the commands Copy, Cut and Paste
from the Edit menu, or by clicking the mouse´s right but-

ton. 

Or, you can click the corresponding function icons on

the toolbar.  

  

3. If the destination line is reserved, you also need to con-

firm, whether to overwrite the old information or not. 

 - To overwrite the old information, click Yes while the

Dialog box is displayed. 

 - To preserve the old information and transfer the new

information to another free slot (Index number), click

No while the Dialog box is displayed. 

Copy Cut Paste
14 SIM FEATURES: PHONE BOOK



PART B: CONFIGURING SETTINGS FOR THE SERAPH
Arranging entries
Arrange the phone book by Index, Name, or Number either

by

 - clicking the title

 - choosing the option from the Edit menu 

 - clicking the mouse´s right button.

•Sort by: Rearranges the phone book permanently. When

transferring the phone book data back to the device, the

data will be arranged by the new order. 

•View by: Rearranges the phone book temporarily. When

transferring the phone book data back to the device, the

data will be arranged by the old order.
SIM FEATURES: PHONE BOOK 15



PART B: CONFIGURING SETTINGS FOR THE SERAPH
SERAPH SETTINGS: CALLS

Calling

STORING NUMBER FOR MAKING CALLS

Key in the phone number for making information calls (1).

The name associating the number is displayed, if it is stored

in the phone book and read from there (1a). For more infor-

mation on storing the phone book information, see EDITING

AND ADDING AN ENTRY ON PAGE 14. 

If  the number field is left blank, information calls cannot be

made.  

STORING NUMBER FOR SENDING POSITION 
REPORTS

Key in the SMS number for sending position reports (2). The

name associating the number is displayed, if it is stored in

the phone book and read from there.  

If the number field is left blank, position reports cannot be

sent. 

NOTE: After sending position report, the receiving party

might call back to the device. The call will be put through if

the caller is an allowed caller. It is possible to attach auto-

matic answer to the incoming call, as well. For more infor-

mation, see ALLOWED CALLERS ON PAGE 17. 

For more information on making information calls and

sending position reports, see MAKING INFORMATION CALLS ON

PAGE 38. 

1a 1

2
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PART B: CONFIGURING SETTINGS FOR THE SERAPH
Allowed callers
You can restrict callers if you like. You have three alternative

settings to choose from: All, Only listed, and None. 

 

ALLOWING ALL INCOMING CALLS 

The All option has no blockage at all, all incoming calls are

welcome and put through. To select it, check the box (1).

By checking the Answer automatically box (1a), all incoming

calls will also be answered automatically. The device con-

tains a built-in microphone and speaker and after certain

number of rings, the device will answer an incoming call au-

tomatically by opening audio to the allowed caller. 

ALLOWING PART OF THE INCOMING CALLS 

You can specify allowed callers (2), i.e. the ones, who are

permitted to call to the device at any time: Only listed callers

are always put through - calls from other numbers are

blocked. 

Key in the phone numbers (2a). The names associating the

numbers are displayed, if they are stored in the phone book

and read from there (2b). You can also attach automatic an-

swer function to the desired numbers by checking the cor-

responding boxes (2c). 

NOTE: The listed numbers must have the CLIP (Call Line

Identification Presentation) feature enabled and roaming

should also support it. If the CLIP support is not ensured,

select the previous option Allow all incoming calls.   

BLOCKING ALL INCOMING CALLS

The None option blocks all incoming calls with no exception

whatsoever (3).  

1a

2a2b 2c

1

2

3
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PART B: CONFIGURING SETTINGS FOR THE SERAPH
Ringing (sound options)

SELECTING TONE 

You can select tone for incoming call. Click the arrow and

highlight the desired option (1).   

ADJUSTING VOLUME

You can select volume level for incoming call, information

call and notification tones. Click the arrow and highlight the

desired option (2).   

SETTING INCREASING VOLUME 

You can make the ringing tone increasing by checking the

box. To have the ringing tone fixed, leave the check box

blank (3). 

Increasing ringing tone can be used in incoming calls, noti-

fication tones are always fixed.   

SETTING VIBRATION 

By checking the box, the device will vibrate when a call is

coming (4). Vibration can be used concurrently with the

ringing tone, or instead of it.  

ENABLING HANDS FREE USE 

By checking the box, hands free operation can be used in

calls. This way the device operates as a speaker phone.  

1

2

3

4

5
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PART B: CONFIGURING SETTINGS FOR THE SERAPH
SERAPH SETTINGS: EMERGENCY

1
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PART B: CONFIGURING SETTINGS FOR THE SERAPH
SELECTING ACTIVATION METHOD    

You can determine the way the emergency cycle will be start-

ed: 

•By pressing and holding down the BeneGuard button for

a few seconds once or 

•By pressing the button briefly twice. 

Click the arrow and highlight the desired option (1). 

SELECTING CANCELLATION TIME

After pressing the BeneGuard button in order to start the

emergency cycle, calls and reports (short messages) can still

be cancelled. Cancellation time is a kind of delay: A report

will not be sent or a call will not be made if it is cancelled in

the pre-defined time.   

You can select the time in seconds that the cancellation

needs to be done: Click the arrow and highlight the desired

option (2). Note that if the cancelling time is set to zero (0),

there is NO possibility to cancel the whole emergency cycle. 

When cancelling the emergency call or report, the Bene-

Guard button must be pressed and released during the time

of delay (e.g in 7 sec.). For more information, see CANCEL-

LING EMERGENCY CYCLE ON PAGE 40. 

STORING EMERGENCY NUMBERS FOR
REPORTS AND CALLS

The emergency reports are sent and emergency calls are

made to the emergency numbers stored in the Reporting and
calling list. 

Key in the report numbers (3) and/or call numbers (4).  The

names associating the numbers are displayed, if they are

stored in the phone book and read from there. 

The numbers are in priority order, starting from the top of

the list. These numbers work as "a chain": 

If the first number is unreachable (after two attempts), the

device calls or sends the report to the second number. If it

is not answered either, the device will go on to the third

number on the list and so on. 

The device tries to reach contact with the other numbers

once before moving on to the next number on the list. If

there is still no answer after going through the whole list,

the calling procedure will be started all over. The device

makes three rounds. 

For more information on emergency cycle, see EMERGENCY

CYCLE ON PAGE 39.
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PART B: CONFIGURING SETTINGS FOR THE SERAPH
SELECTING PROCESSING ORDER

You can define order for making emergency (voice) calls

and sending emergency reports while the emergency cycle

is on. Click the arrow and highlight the desired option (5). 

You have two choices: 

•Reports and calls in pairs: The device will make a voice call

and send an SMS in pairs according to the list order, start-

ing from the top.  

•All reports before calls: When the emergency cycle is initi-

ated, first the device will send the emergency reports,

after which the voice calls will be made starting from the

top of the list of the emergency numbers.  

SETTING TIMEOUT FOR CALL ATTEMPTS 

You can define for how long a time the device tries to call a

single emergency number before moving on to the next

number in the list of emergency numbers. 

Click the arrow and highlight the desired option (6).  

SELECTING CALL MODE

To select the call mode, click the arrow (7) and highlight the

desired option: Audio both ways or Audio to emergency num-
ber. 

If there is a need to ask directions or have a conversation,

the call mode should be set to Audio both ways. 

If there is a need to quietly listen in the surroundings of the

device, the call mode should be set to Audio to emergency
numbers. By using this option, the emergency number be-

comes a silent listener: Not a sound is heard from the emer-

gency number.     

SETTING HANDS FREE IN EMERGENCY MODE 

By checking the box (8), hands free operation can be used

in emergency calls. This way the device operates as a speak-

er phone. 
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PART B: CONFIGURING SETTINGS FOR THE SERAPH
SETTING CONFIRMATION FOR EMERGENCY
REPORT DELIVERY

By checking the Resend unconfirmed reports box (9), you can

request a confirmation just to make sure that someone has

received an emergency report. The device will resend the

emergency reports until it receives a confirmation of the

successful delivery.

By selecting a value in Resend timeout data field, you can

specify the waiting time, i.e. for how long a time the device

waits for the confirmation before trying to reach some other

emergency report number (9a). 

NOTE: This feature is not supported in all control systems.

Using this feature in a system which does not support it can

lead to massive resending of messages and high charges. 

SETTING DISPLAY NOTIFICATIONS

To make the device to display emergency cycle notifications,

check the Display notifications box (10). This way you can

see clearly how the emergency cycle is proceeding. 

If you want the device to make discreet emergency cycle

with no lights, or display notifications on, leave the check

box blank. Moreover, to make it also silent, leave the Play
tones check box blank (see below).  

SETTING CALL NUMBER MASK

You can name the emergency cycle as you like (11). This is

the way to mask the real phone number to which you are

calling.   

The "nickname" will be displayed during an emergency 

cycle. 

SETTING EMERGENCY TONES

To make the device to play tones during an emergency cycle,

check the Play tones box. This way you can hear how the

emergency cycle is proceeding.   

If you want the device to make silent emergency call, leave

the Play tones check box blank (12). To make it also show

no lights or emergency displays, leave the Display notifica-
tions box blank (see above). 

SETTING VIBRATION

By checking the box, the device will vibrate during an emer-

gency cycle.  Vibration can be used concurrently with emer-

gency cycle tones, or instead of them. 

Vibration is not in use if the check box is left blank (13). 
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PART B: CONFIGURING SETTINGS FOR THE SERAPH
SETTING MANUAL EMERGENCY MODE 
TERMINATION

By leaving the check box blank, the emergency mode ends

and the device returns to normal mode automatically, after

going through the emergency cycle.  

By checking the box, emergency mode is on until it is turned

off manually (14). While the emergency mode is on, emer-

gency numbers are allowed to track the device without fur-

ther notice right after the emergency cycle is put through.

Ongoing emergency mode means also that the emergency

display and tone settings are on until the emergency mode

is ended. E.g. if the device is set to be silent during emer-

gency mode, it will stay silent, even if the device receives in-

coming call.    

When the tracking is not needed any more, the emergency

mode can be ended by pressing the c key. 

NOTE: To allow emergency numbers track the device tem-

porarily, check the Manual emergency mode termination box,

and check the Authorization On box. For more information

on authorization, see AUTHORIZATION ON PAGE 25.   

For more information on using and ending emergency

mode manually, see ENDING EMERGENCY MODE MANUALLY ON

PAGE 41.  
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SERAPH SETTINGS: TELEMATICS
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PART B: CONFIGURING SETTINGS FOR THE SERAPH
Service center number
You can change and store the phone number, which is used

for sending  telematics protocol messages to the service cen-

ter. Service center number can have control over the device

at all time and thus it is always authorized. 

Key in the number of the service center (1). 

Authorization

SPECIFYING AUTHORIZED NUMBERS 

The device is allowed to respond to protocol messages from

the authorized numbers automatically at any time. 

1. Always authorized numbers are: 

 - The numbers stored in the Authorization On list and 

 - The number stored as the Service center number.   

2. Authorization can also be temporary, permission given

from time to time under special conditions, such as in

emergency mode. Temporarily authorized numbers can

be:  

 - The emergency numbers stored in the Reporting and
calling list.  

AUTHORIZATION OFF

If authorization is turned off (2), all requests are automati-

cally processed.

If the service center number is defined, any responses are al-

ways sent to that number. 

If the service center number is NOT defined, responses are

sent to the number from which the request came. 

AUTHORIZATION ON

If authorization is turned on (3), all requests coming from

authorized numbers are automatically processed. Any re-

sponses are sent to the number from which the request

came.  

All requests coming from unauthorized numbers are dis-

carded.   
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PART B: CONFIGURING SETTINGS FOR THE SERAPH
Message settings

MESSAGE RECEPTION 

Select tone and volume level for incoming messages (4).

Click the arrows and highlight the desired options.  

MESSAGE SENDING TONE  

Select tone and volume level for outgoing messages (5).

Click the arrows and highlight the desired options.  

SMS CENTER NUMBER

SMS center number (6) is needed for sending telematics pro-

tocol messages and normal short messages. However, send-

ing normal short messages is possible only while the device

is connected to an external device.   

Most SIM cards have the SMS service number already stored.

Thus setting the number in most cases is not necessary. 

The number must be set correctly, otherwise sending short

messages is not possible. The SMS service number can be

found e.g. in the manual of your local network operator. 

MESSAGE VALIDITY

You can select the length of validity for normal short mes-

sages and telematics protocol messages, i.e. for how long

the SMS messages are stored in the server of the operator.

This setting can be used to avoid massive helping efforts in

case an emergency message has been sent a week ago and

there is reason to believe that help is no longer needed.

You can choose the message validity from these: 1 hour, 6
hours, 24 hours, 1 week or Maximum time. 

Click the arrow and highlight the desired option (7).
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PART B: CONFIGURING SETTINGS FOR THE SERAPH
SERAPH SETTINGS: POWER

Settings for manual power on and off
•No restrictions (1) - The device can be turned on and off as

usual. The service center will NOT be notified of the

power on/off. 

•Notify service center (2) - The service center will always be

notified when the device is powered on or off. Notifying

means sending a protocol message to the service center. 

•No power-off (3) - The device cannot be powered off nor-

mally (by pressing /). Moreover, if the device powers off

for some reason (e.g. Low battery), the device will send  a

protocol message to the service center.    

Settings during battery loading    

CHANGE GPS OPERATING MODE

You can select, which one of the GPS power modes is on

while the device is being charged. 

By selecting No change, the GPS mode remains in the previ-

ously configured operating mode (i.e. its normal operating

mode).  

Set the GPS Off in case  

•the time reserved for charging is quite short

•GPS functions are not needed during charging process. 

Click the arrow and highlight the desired option (4).  

NOTIFY SERVICE CENTER WHEN CHARGING 

By checking the box (5), the device will notify the service

center in case the device is connected to a charger or discon-

nected from it. 

Notifying means sending a protocol message to the service

center, including the latest position.   
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PART B: CONFIGURING SETTINGS FOR THE SERAPH
SERAPH SETTINGS: GPS

SETTING GPS OPERATING MODE

The GPS receiver in the device uses power saving options for

ensuring maximum battery capacity. Click the arrow and

highlight the desired option (1). The GPS receiver has three

modes: 

•Off 

•Economy

•Full power (without the power saving option).

Operating mode depends on the way, the device is used. Au-

tonomous system, i.e. the portable device, normally uses

Economy mode, while device with constant power supply,

i.e. a fixed device, uses Full Power mode.

SLEEPING TIME (IN ECONOMY MODE)  

As a default setting, the GPS economy mode calculates posi-

tion approximately every 45 seconds. The position interval

consists of two things: 

•An ideal sleeping time for the GPS plus 

•An actual time needed for searching satellites and calcu-

lating position by the GPS. 

The sleeping timeis adjustable (1a). In the Benewin, key in

the sleeping time in seconds. The sleeping time should be

rounded to tens, otherwise the software does the rounding.

E.g. by entering 27, the ideal sleeping time will be rounded

to 30 seconds. Note that 20 seconds is the minimum value. 

NOTE: The time needed for searching and calculating satel-

lites depends on present circumstances, e.g. satellite cover-

age, age of the latest position fix, distance from the previous

to the current position and so on.  

POOR SATELLITE COVERAGE 
Notify service center when satellite coverage drops: The de-

vice can be configured to notify the service center if the sat-

ellites are suddenly dropped and position is lost, e.g. when

entering in a building. 

Key in the number in minutes (2). The timeout indicates, for

how long the device is allowed to stay in poor satellite cov-

erage before sending a protocol message to the service cen-

ter - the smaller the number you set in here, the faster the

device will react to lost satellites and the sooner the notifi-

cation will be sent.  

2
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PART B: CONFIGURING SETTINGS FOR THE SERAPH
WAYPOINT TRACKING  

Waypoint tracking is remotely controlled by the service cen-

ter. When the waypoint tracking is turned on, the alarm

(incl. position information) will be sent to the service center

when the device is moving out or in to the pre-defined area.

The device can also be configured to send the position in-

formation to the service center whenever crossing the bor-

derline - despite of the moving direction. 

NOTE: When entering into the pre-defined area, the alarm

will be sent when crossing radius. When entering out of the

pre-defined area, the alarm will be sent when crossing radi-

us plus perimeter of 100 meters. 

•Name (1): You may key in the desired name for a waypoint

. You can define up to 30 separate, circular areas: The

areas are separated from each other by an ID number and

a  name.  

•Center point coordinates (2): The waypoint area is defined

by keying in Latitude and Longitude and a Radius of an

area in meters. The radius should be rounded to tens,

otherwise the software does the rounding. E.g. by enter-

ing 67, the actual radius will be rounded  to 70 meters. 50

meters is the minimum value. 

•Alarm (3): After activating a waypoint, you can select an

alarm option for this waypoint. You have three choices:

Alarm will be turned on when arriving to a waypoint,

departing from a waypoint, or whenever crossing the bor-

derline (both directions). Each waypoint can have alarm

option of its own. 

•Activation of a waypoint (4): To activate a waypoint, check

the Active box (on the same row), to deactivate the way-

point, leave the check box blank. 

NOTE: The waypoint tracking does not contain automatic

switch off or duration options. The feature must be sepa-

rately deactivated when it is no longer needed.  

RESETTING THE COORDINATES 

To reset the coordinate values, click the latitude and longi-

tude data fields  (the ones, you want to reset). 

MARKING ALL WAYPOINTS FOR ACTIVATION/
DEACTIVATION AT ONCE 

Click the Active box on the top row (5). 

Note that activation/deactivation will actually take place

only after you have transferred the information to the de-

vice. 

1 2 345
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PART B: CONFIGURING SETTINGS FOR THE SERAPH
CODE SETTINGS

Automatic PIN entry
The PIN code can be stored to the EEPROM of the device. It

cannot be read by any means from the device. In startup the

PIN code is entered automatically by the device software. 

To store the PIN code, select Save PIN code from the Mobile
menu. Key in the new code and confirm it.

To change the PIN code, select Change PIN code from the

Mobile menu. Key in the new code and confirm it.

NOTE: The PIN entry option is available only when the de-

vice is connected to the software. After storing the PIN code,

make sure to transfer the setting to the device. 

Security code 
The security code can be set to secure Waypoint tracking
and/or  Seraph settings. If the setting is enabled, the code is

requested each time when powering on the system (Be-

newin software in connection with the device).  

The security code settings are located in the Mobile menu.

•You can secure both settings, one of them, or none of

them. To attach the code to the setting, check the box -

otherwise leave the check box blank (1). Click Ok. 

•To change the code, first click the corresponding box (2).

Key in the old code, key in the new code and confirm it

(3). Click Ok (4).  
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PART C: OPERATING THE SERAPH
PART C: OPERATING THE 
SERAPH

USER INTERFACE 

Turning the device on 
1. To power on the device, press the upmost side key / and

hold it down for a few seconds.   

2. The logo will be shown. 

3. An automatic PIN code entry will take place. If the PIN

code is requested, the PIN code must be programmed in

the device in advance. For more information, see AUTO-

MATIC PIN ENTRY ON PAGE 30.

4. The device will remove all  short messages found on SIM

card and go to stand-by mode. The device may also no-

tify the service center of the power on. For more infor-

mation, see SETTINGS FOR MANUAL POWER ON AND OFF ON

PAGE 27. 

There are two other ways to power on the device: 

•By pressing the BeneGuard button < and holding it

down for a few seconds. NOTE: This action will start the

emergency cycle (unless cancelled in time).  

•By connecting the device to a charger.

SIDE KEYS
•Upmost:
Power  on/off

•Middle: For 
increasing volume

•Lowmost: For 
decreasing 
volume and silen-
cing ringing tone

DISPLAY
•GSM  status
•GPS status  
•Battery status 

BENEGUARD BUTTON
For making emergency 
calls/sending emergen-
cy messages

BATTERY

Battery release 
catch

SYSTEM 
CONNECTOR
For connecting 
charger or data
cable to the 
device.  

MICROPHONE

Plug for external 
GPS antenna

GPS ANTENNA

SEND KEY
•For making 
information call/
sending position

•For answering calls

LOUDSPEAKER

END KEY
•For rejecting/
ending calls   

•For cancelling  
some  operations 

NOTE: If the PIN code is incorrect or the SIM card is
not inserted at all, the normal network connection is
unavailable and the device can only be used for ma-
king network emergency calls (e.g. 911, 112).  
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PART C: OPERATING THE SERAPH
Turning the device off 
1. To power off  the device, press the upmost side key /

and hold it down for a few seconds. Note that some con-

figurations do not allow the device to be turned off nor-

mally.  

2. The logo will be shown and the Power off tone heard. 

3. The device may also notify the service center of the pow-

er off. For more information, see SETTINGS FOR MANUAL

POWER ON AND OFF ON PAGE 27. 

Adjusting volume
To adjust speaker volume during a call, press the lower side

keys briefly. 

•The z key increases the volume

•The y key decreases the volume. 

Silencing alert tone
When the device alerts of an incoming call, the alert tone

can be silenced by pressing the lower side key y briefly. 

About tone notifications
Tones are played through the loudspeaker simultaneously

when corresponding notifications are displayed. There are

several different tones informing of various situations. 

Display indicators

GPS POSITIONING
INDICATORS 

BATTERY INDICATOR

GSM NETWORK
INDICATORS

NETWORK OPERATOR/
SERVICE PROVIDER  
IDENTIFIER 

DEVICE IN STAND-BY MODE

GPS is active

GPS is sleeping

GPS is turned off /GPS has encountered an error

Bars on the left indicate accuracy of the latest
position fix; The more bars and the taller the bars,
the better the position.  
 - Four bars - the most accurate position 
 - No bars - no position. 

GPS POSITIONING STATUS
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PART C: OPERATING THE SERAPH
Display/tone notifications

The water level indicates charge left in the bat-
tery. The higher the level, the more charge is left. 

During charging, the water level will move upwards
and downwards, freezing for a quick moment to
show the current charge status, and start over.   
When the water level stops moving, the battery is
fully charged (or the charger is disconnected). 

BATTERY STATUS

GSM is on

GSM is off/Incorrect PIN code has been entered,
or invalid SIM card inserted.

A triangle is shown beside the GSM icon when the
phone is roaming (using other than own network).

Bars on the right indicate strength of the GSM
network. The more bars and the taller the bars, the
better the GSM network.   
 - Four bars - high network strength 
 - No bars - no network.  

GSM NETWORK STATUS

Processing. An operation is in progress,
please wait. 

General failure. Shown when an operation
fails. E.g. if you try to make a call when
there is no number pre-configured in the
device. Simultaneously, the Failure tone is
played once.   

SIM failure. Shown when there is no SIM
card inserted in the device, or if the PIN
code was rejected. Simultaneously, the Fail-
ure tone is played once. 

GENERAL NOTIFICATIONS

Battery low. Shown when there is a need to
recharge the battery (or replace it with anot-
her recharged battery). Simultaneously, the
Battery low tone is played once.

The device is connected to a charger. Set-
tings during battery loading take place.
Simultaneously, the Charging tone  is played. 

The device is disconnected from a char-
ger. Settings during battery loading are
ended, the device returns to normal mode.  

CHARGING NOTIFICATIONS 
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PART C: OPERATING THE SERAPH
Starting emergency cycle (a long press):
Emergency tone settings are switched on. 

Press the BeneGuard button and hold it
down until the wedges are all turned
black.     

STARTING EMERGENCY CYCLE NOTIFICATIONS (DISPLAYS ON) 

Starting emergency cycle (two quick
presses): Press the BeneGuard button
briefly. Emergency tone settings are swit-
ched on. 

Press the button again when the second
circle starts blinking.  

Emergency cycle cancellation period.
A countdown timer is shown on the bot-
tom. The timer counts the cancellation
time left (in seconds). Simultaneously, the
Cancellation tone is played. To cancel the
emergency cycle, do it while this notifica-
tion is shown (by pressing the c key). 

During the discreet emergency cycle, the
device looks like it is in stand-by mode. The
only indicator of the ongoing emergency
cycle is the handset turned black. When the
handset turns white, the cycle is over.

DISCREET EMERGENCY CYCLE (DISPLAY NOTIFICATIONS OFF)

Emergency cancellation. Shown right
after the emergency cycle was cancelled.  

Emergency completion. Shown when the
emergency cycle ends normally, or when
the emergency mode is ended manually.   

Emergency call retry. Emergency num-
bers can be voice call numbers. The notifi-
cation is shown when the device makes
another call attempt to a number. 

Emergency mode/Working. The device is
through with emergency calls, but sending
messages, message confirmation or posi-
tion refresh is still going on.  

Emergency confirmation message recei-
ved. After receiving confirmation, the
device will end resending of an emergency
message. Simultaneously, the Message
reception tone is played once. 

"Post-emergency mode". The GSM opera-
tor´s name is replaced by the emergency
symbol. While this notification is shown,
the device can be tracked by emergency
numbers, also emergency tone and display
settings are kept on. This mode can be ter-
minated manually, by pressing the c key.  

OTHER EMERGENCY CYCLE NOTIFICATIONS (DISPLAYS ON)
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PART C: OPERATING THE SERAPH
Network emergency call query. Shown
when the BeneGuard button is pressed but
making emergency cycle is NOT possible
(e.g. SIM card is missing ). 

NETWORK EMERGENCY CALL

Normal incoming call. If available, the
name associated with the calling number/
the phone number itself is shown on the
bottom. Shown until the call is answered. 

Initiating information call or position
report. Press the  l key and hold it down
while this notification is shown. 

Sending a position report. 
Simultaneously, the Message sending tone is
played once. 

Making an information call. Shown until
the call is answered.  

A call is in progress. Shown while the call
is connected. 

NOTIFICATIONS REFERRING CALLS OR MESSAGES
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PART C: OPERATING THE SERAPH
INCOMING CALLS AND MESSAGES
For incoming calls and messages 

•A valid SIM card must be inserted and  

•The device must be turned on. 

Receiving calls 
Depending on configuration, the device receives calls from

any numbers, from no numbers at all or only from the num-

bers stored as allowed callers. 

For more information, see ALLOWED CALLERS ON PAGE 17.  

The name of the caller is displayed, if it is stored in the

phone book and read from there. 

Answering incoming calls
There are two ways to answer an incoming call: 

•Manual answer: You can press the Hook-up key l when

the device alerts, or 

•Automatic answer: The device will answer incoming calls

automatically. This is done in case the Automatic  answer
function is turned on. The Automatic  answer can be

attached to all incoming calls or to some calls made from

specific numbers. For more information, see ALLOWED

CALLERS ON PAGE 17. 

Incoming short messages
An incoming short message is echoed to the system connec-

tor, so that an external device can check it. 

No messages are ever stored on SIM card. Even the MPTP

messages are cleared once they are processed. 

NOTE: The device cannot receive normal short messages by

itself, or when it is connected to the Benewin. If the device

is connected to some other application, receiving normal

short messages may be possible.      

Incoming MPTP messages
An incoming short message is processed only if it is a known

MPTP message. However, if the Authorization setting is en-

abled, only messages from authorized numbers are pro-

cessed, others are discarded at once. Numbers stored as

Service center and Authorized numbers are always authorized

and processed. For more information on authorization, see

AUTHORIZATION ON PAGE 25.

In most cases, incoming MPTP messages are either remote

configuration/activation messages or various types of posi-

tion request messages.  
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REMOTE CONFIGURATION MESSAGE

The device may receive a specific MPTP message for the re-

mote configuration. Remote configuration messages con-

tain settings for e.g. emergency numbers, authorized

numbers, tracking, area tracking, and GPS operating mode. 

For more information on remote configuration, please see

the separate document on MPTP commands, located at the

Web site: www.benefon.com. 

LOCATION REQUEST MESSAGES 

The device may receive several different messages request-

ing location.  Such messages could be, e.g. Location request

(LOC) messages, Location history request (HIS) messages.

For more information on how the device responds these

messages, see POSITIONING FEATURES ON PAGE 42. 

For more information on how to create location request

messages, please see the separate document on MPTP com-

mands, located at the Web site: www.benefon.com. 

AT commands
The device may receive an AT command via the system con-

nector. The AT commands can be used for carrying out sim-

ilar things that are done via MPTP messages. 

For example, AT commands are used when configuring set-

tings to the device locally, by using the Benewin software.   

For more information on handling AT commands, please see

the separate document on AT commands, located at the Web

site www.benefon.com.  
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OUTGOING CALLS AND MESSAGES
The device can be used for 

•making information calls and/or 

•sending position reports and

•making emergency calls and/or

•sending emergency messages.  

In addition, the device may automatically send some MPTP

messages to the service center or some other authorized

number. Such messages can be, e.g. 

•Power notifications

•Lost satellite coverage notifications 

•Position updates (e.g. when the device is being tracked in

emergency mode) 

•Some other types of calculated positions sent in sequence

(e.g. by using Waypoint tracking)  

•Individual position information sent as a response to an

MPTP request (e.g. Tracking, Area tracking, Location

request, History request). For more information, see POSI-

TIONING FEATURES ON PAGE 42.  

For more information on MPTP messages, please see the

separate document on MPTP commands, located at the Web

site: www.benefon.com. 

 Making information calls 
To make an information call, press l and hold it down for

a few seconds.   

The call number needs to be configured in the device in ad-

vance. Depending on configuration, the device may simulta-

neously send position report, as well. For more information,

see CALLING ON PAGE 16. 

Sending position reports
To send a position update, press  l and hold it down for a

few seconds.  

The position report number must be configured in the de-

vice in advance. Depending on configuration, the device

may simultaneously make information call, as well. For

more information, see CALLING ON PAGE 16. 

NOTE: The recipient of the position report might call you

back. In this case, you can answer the incoming call by press-

ing l. Depending on configuration, the device may also an-

swer the incoming call automatically. In order to receive the

incoming call, the caller must be an allowed caller. For more

information on both settings, see ALLOWED CALLERS ON PAGE

17. 
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Emergency cycle
Emergency cycle means making specific emergency call to

pre-configured numbers. During the emergency cycle pre-

configured emergency settings (e.g. tone and display set-

tings) are automatically switched on until the cycle is over.

Depending on configuration, the emergency settings can be

kept on even after the cycle is over.  

Depending on configuration, the emergency call can con-

tain both (voice) calls and messages. Calls can be made to

mobile phone numbers, or normal phone numbers. Messag-

es are protocol messages sent to mobile phones via SMS.

The emergency message contains both GPS coordinates and

GSM network measurement report. 

The emergency numbers are in priority order, starting from

the top of the list. These numbers work automatically, 

as "a chain", through the list. If the first number is unreach-

able (after two attempts), the device calls or sends the re-

port to the second number. If it is not answered either, the

device will go on to the third number on the list and so on. 

The device tries to reach contact with the other numbers

once before moving on to the next number on the list. If

there is still no answer after going through the whole list,

the calling procedure will be started all over. 

For more information on the emergency cycle process, see

STORING EMERGENCY NUMBERS FOR REPORTS AND CALLS ON

PAGE 20. 

Emergency cycle is started by pressing once the BeneGuard

button <, located on the top of the device. The button

must be pressed the way it has been configured: A long

press or two quick presses. For more information, see SE-

LECTING ACTIVATION METHOD ON PAGE 20. 

The emergency cycle is over when the calls are made and

messages are sent (if the cycle is  not interrupted, or can-

celled), and the device returns to normal operation.  

CIRCUMSTANCES WHICH MAY AFFECT ON EMERGENCY CYCLE
1. Being in a shadow area of the GSM network at the time of

the event.  

2. Poor GPS coverage during emergency cycle may cause
the emergency cycle completion to slow down.      

3. Busy telephone line - applies to a voice call connection. 

4. Message transmission error caused by the carrier of an
SMS, i.e. the network operator.
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MAKING AN EMERGENCY CALL WHICH
INCLUDES BOTH CALL NUMBERS AND SMS 

NUMBERS     

1. Press <.   

2. The device sends the message including position infor-

mation. If current position coordinates are not available,

previous coordinates will be sent instead. 

3. If the Resend unconfirmed reports setting is turned on,

the device will go on sending the message until receiving

party sends confirmation to the device. For more infor-

mation, see SETTING CONFIRMATION FOR EMERGENCY RE-
PORT DELIVERY ON PAGE 22.   

4. Microphone opens audio to emergency numbers or both

ways, depending on selected Call mode. For more infor-

mation, see SELECTING CALL MODE ON PAGE 21. 

5. The device alerts until the call is answered.

6. A voice call in progress.  

CANCELLING EMERGENCY CYCLE

As a sign of cancellation period, you may hear the cancella-

tion tone. You may also see a timer indicating time left for

cancellation.    

•To cancel the entire emergency cycle, press  the c key

briefly during the cancellation period. 

•When the emergency cycle has already started, it cannot

be cancelled entirely, but the rest of the emergency calls

and messages can be cancelled. In order to do so, press

the  c key and hold it down for five (5) seconds.     

When the cancellation is succeeded, the device will return

to normal operation.  

NOTE: Cancellation time must be configured in the device in

advance, otherwise the whole emergency cycle cannot be

cancelled at all. For more information, see SELECTING CAN-

CELLATION TIME ON PAGE 20. 
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ENDING EMERGENCY MODE MANUALLY

Depending on configuration, the emergency cycle can be

ended either automatically or manually. 

Manual ending of the emergency cycle means, the emergen-

cy numbers are permitted to track the device without fur-

ther notice after the emergency cycle is put through. The

emergency settings are kept on until the emergency mode is

ended. This additional feature is for increasing user´s safety

in an emergency situation.  

While the device is being tracked, it will discreetly send po-

sition messages to the tracking number informing of its cur-

rent location. The tracking number can be e.g. an

emergency number or service center number. 

•To end the emergency mode, press the c key briefly. 

NOTE: In case an emergency number is also stored in autho-

rized numbers list, the emergency number is authorized

permanently. In practise, it means that this number can go

on tracking the device even after the emergency mode is

ended.    

For more information on configuring the way to end the

emergency mode, see SETTING MANUAL EMERGENCY MODE TER-

MINATION ON PAGE 23. 

Making network emergency call
Making calls and sending messages to normal phone num-

bers or the emergency numbers is NOT possible in these

cases: 

 - The device has no SIM card inserted or

 - The PIN code has been rejected or 

 - The list of emergency numbers (Reporting and calling
list) is blank or

 - The network being used only allows calls to the net-

work emergency number (e.g. 112, 911). 

If the BeneGuard button is pressed under the circumstanc-

es, the device will display SOS query: 

•To make the network emergency call, press l. 

•To cancel the call, press c or do nothing. 
OUTGOING CALLS AND MESSAGES 41



PART C: OPERATING THE SERAPH
About sending messages 
The device has MPTP message storage: If sending of an MPTP

message fails e.g. in case there is no service at the moment,

the device will send the message later, assuming the MPTP

protocol message storage has space left to deposit the mes-

sage. The storage capacity is 100 messages. After the device

is in service again, these messages are automatically sent for-

ward.

Message type: As a default value, the message type is set to

Text messages. 

Power notifications

BATTERY LOW MESSAGE

When the device detects the battery is low, the device will

send an appropriate MPTP message to a specific number, as-

suming the MPTP power notifications are enabled. 

The message will be sent only in case the event takes place

for the first time after powering on or being disconnected

from the charger.  

CHARGER CONNECTION MESSAGE

When the device detects that it is being connected to or dis-

connected from the charger, the device will send an appro-

priate MPTP message to a specific number, assuming the

MPTP power notifications are enabled.  

POSITIONING FEATURES
For more information on supported telematics features of-

fered by MPTP, see the separate MPTP list in the last chapter

of this manual: Appendix. 

For more information on MPTP messages, please see the

separate document on MPTP commands, located at the Web

site: www.benefon.com. 

Responding location request 
messages

The device responds the location request this way: The de-

vice checks the age of the latest position stored in the mem-

ory. 

If the device finds fresh position (less than 1 minute of age)

stored in the memory, the device sends the position imme-

diately to the requesting number.  

If the position found is an old one (more than 1 minute of

age), the device switches the GPS on (if it is currently off),

and tries to update position within 4 minutes.  

 - Position update successful within 4 minutes -> New

position is sent to the requesting number.

 - Position update not possible within 4 minutes -> Old

position and data is sent to the requesting number,

NOT updated.
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After this, a position is sent, GPS is switched off and the de-

vice returns to normal operation. 

The message includes a time stamp indicating age of the po-

sition. 

Responding location history request
messages

The device responds the location history request this way:

It sends the latest position to the requesting number imme-

diately. The position sent is the very latest one found in the

device memory. The GPS stays in off-state: Position is NOT

refreshed. 

In addition to the latest position, the device may send sev-

eral old positions (i.e. position history) with desired inter-

vals to the requesting number (most likely: the service

center number). If requested, the whole trace of the device

can be unravelled afterwards. 

Network positioning support
The device can be requested to send its current GSM net-

work parameters at any time. Requesting number can be e.g.

service center. The message that the device sends as a re-

sponse is called the Network Measurement Report (NMR). 

The device will send network parameters to the requesting

number automatically in these cases: 

•Authorization is enabled and the requesting number is

authorized.

•Authorization is entirely disabled and the service center

number is NOT configured in the device. 

Service center number and numbers stored as Authorized

numbers are always authorized. Emergency numbers are au-

tomatically authorized only during emergency mode (if the

emergency mode is configured to be terminated manually).  

If the authorization is enabled and the position request

comes from an unauthorized number, the  device will dis-

card the request. 

If the service center number is defined and authorization is

disabled, the response is always sent to the service center

number.

The Network Measurement Report contains rough data and

the position needs to be separately calculated by taking into

account surrounding base stations and distances in between

them. Calculation of the position needs a separate server,

available from Benefon Partners. The device cannot calcu-

late the position based on network parameters by itself. 
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PART D: POWER MANAGEMENT 

POWER SUPPLY

•Mains charger CMA-70-230 (with the cable FMC-70)

•Cigarrette lighter charger CCS-71-12

•Standard Li-Ion batteries 

 - 650 mAh (BBL77S)

 - 900 mAh (BBL77N)

 - 1200 mAh (BBL77P)

 - 1700 mAh (BBL77G). 

The battery type may vary depending on the market area and

sales package. In unclear cases, check the battery compati-

bility with the dealer. 

MAINS CHARGER 
The mains charger should only be used indoors. Make sure

that the voltage in the country which you are staying corre-

sponds to the voltage (230 V) of the charger.

When charging, connect the charger (round) end of the ca-

ble into the charger and lock it by turning it half a turn

clockwise. Plug the square end of the cable (with the arrow

facing up) into the system connector on the device. 

Plug the charger into a mains outlet. Charging will start au-

tomatically.

The mains charger is provided with the device, but is also

available from the assortment of Benefon accessories. For

more information on other charger types, see PART E: ACCES-

SORIES ON PAGE 46.

CHARGING
The battery must be fully charged before taken into use. The

battery will reach its full capacity only after two or three

charging times.  

The device controls the charging status, the battery temper-

ature and power supply during the charging operation.  
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The ideal temperature range for charging is +10°...+30°C. If

charging the battery above or below these temperatures the

life of a battery may be shortened. Also, the battery may not

reach full capacity.

Never charge the battery at temperatures below 0°C.

Charging time depends on what kind of a charger and bat-

tery you have in use. When charging the Li-Ion batteries with

the quick charger, about 70% of the battery capacity will be

charged quickly, but charging the remaining 30% takes rela-

tively more time. 

Also note that humidity, temperature, age of the battery and

currently used features (e.g. the GPS) affect the time spent

on charging.  

BATTERY CARE AND MAINTENANCE
The continuous operating time is less when using an old

battery than when using a new battery.

When storing batteries for a long time, it is recommended

that the batteries are kept cool and fully charged in a dry

place.

Proper care and storage guarantee best possible battery ca-

pacity and maximum battery life. 

DISPOSAL OF A BATTERY
Li-Ion batteries do not contain heavy metals which can dam-

age the environment. Li-Ion batteries should be disposed of

according to the country-specific regulations.
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ORDER CODES

BATTERIES

CHARGERS

EXTERNAL ANTENNAS

CABLES

OTHER ACCESSORIES

NOTE: You will find complete and updated list of accesso-

ries in the web site: www. benefon.com 

GSM ANTENNA ADAPTER

An external GSM antenna is needed if the device is installed

or used in such a location or areas where frequently exists

poor GSM coverage. The external GSM antenna can be, e.g.

a cottage antenna, and you need the GSM antenna adapter

to connect it to the device.

The adapter is a standard cable containing two separate con-

nectors: 

•SMA for the device.  

•FME for the external antenna. 

Device´s own antenna must be disconnected when attach-

ing the GSM antenna adapter. 

Code Part

ZE2400 Standard Li-Ion battery, 650 mAh

ZE2402 Standard Li-Ion battery, 900 mAh

ZE2401 Standard Li-Ion battery, 1200 mAh 

ZE2403 Standard Li-Ion battery, 1700 mAh

Code Part

ZE1106 Mains charger CMA-70-230 (EUR model)

ZE1109 Mains charger CMB-70-230 (UK model)

ZE1110 Mains charger CMD-70-230 (US model) 

ZE1111 Mains charger CMC-70-230  (AU model)

ZE3510 Cigarrette lighter charger CCS-71-12

Code Part

ZE2408 External GPS antenna, Radiall

ZE3232 External GSM antenna, Cottage mount

ZE2102 Cross-country GSM antenna

Code Part

ZE2306 Data cable APC70

ZE2406 Data/NMEA cable APC77

Code Part

ZE5520 Headset 

ZE3117 Light holder

ZE5314 Carrying case (trendline) 
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PART F: TROUBLESHOOTING  

"DUMMY QUESTIONS"

BENEWIN 

POWER AND BATTERIES

CALLS 

Question/Problem Answer/Check points

Today I have time to 
make configurations 
but the device does 
not arrive until tomor-
row. 

You can make the configurations in 
advance. To work in off-line, first select 
Benewin Pro from the Edit menu and set 
Benefon Seraph to be the default Bene-
fon mobile phone. 
Open a blank file by double-clicking the 
desired icon under the My computer 
node. After making configuration, select 
Save as.. from the File menu. 
Select destination directory and name the 
file. Click Save. The software stores the 
information, the node contains. Each node 
must be stored separately. 
When the device arrives, make the cable 
connection and open the Benewin soft-
ware. Click Connect. Select Open from 
the File menu and find the desired file. As 
the file is displayed, you can transfer set-
tings to the device by clicking Save to 
mobile.      

Question/Problem Answer/Checkpoints

The device powers off 
by itself. 

Does the battery have charge left? If the 
battery is low, it must be charged or 
replaced with a charged battery. See 
PAGE 32 and PAGE 44. 
Also note that the device might be config-
ured to inform the service center of power 
changes. See PAGE 27 and PAGE 27. 

Question/Problem Answer/Checkpoints

I want to receive calls 
from some people, 
(like my friends), but 
not from everyone.        

Check that Allowed callers are set to 
Only listed.  Key in the names and num-
bers of the desired callers in this list. See 
PAGE 17.  

I want to be able to 
make an information 
call, but sending posi-
tion report is not nec-
essary.  

Check the Calling data field: Key in the 
name and number in the Call table. Leave 
the Position report table blank. See 
PAGE 16.  
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SOS QUERY

EMERGENCY CYCLE

 

Question/Problem Answer/Checkpoints

Making emergency 
cycle does not work. 
The device just dis-
plays "SOS?"  query. 

Make sure that there is a valid SIM card 
inserted in the device. 
Make sure, the PIN code has been pro-
grammed in the device. If the PIN request 
is on, the PIN code must be set. See  
PAGE 30.  
Have you stored the emergency numbers 
in the Reporting and calling list? See 
PAGE 20. 
Have you transferred settings into the 
device? See PAGE 11

Does the currently used network allow 
calls to numbers other than network emer-
gency number (e.g. 112)? 

Question/Problem Answer/Checkpoints

How can I be sure that 
someone received the 
emergency message?

Turn the emergency confirmation setting 
on. This way the device will continue 
sending the message until it gets acknowl-
edgement message. See PAGE 22 NOTE: 
All control systems do not support this 
feature. 

The device makes 
noise while making 
emergency cycle. I 
want it to be quiet. 

Make sure, the Play tones is turned off 
(check box left blank). See PAGE 22.  

Question/Problem Answer/Checkpoints

What if I accidently 
press the Beneguard  
button; Is it possible to 
cancel the emergency 
cycle somehow? 

What if it has already 
started, is it possible to 
cancel ongoing emer-
gency cycle?

Set emergency cycle cancellation time for 
e.g. 7 seconds. See PAGE 20 . 
Then you can cancel the whole emer-
gency cycle by pressing c within 7 sec-
onds. If you have set emergency tones 
and displays on, you will also hear the 
cancellation tone and see the timer in the 
display. See PAGE 22 and PAGE 22.  

You cannot cancel the ongoing emer-
gency cycle entirely, but you can cancel 
the rest of the emergency cycle by press-
ing c  and holding  it down for about 5 
seconds.       

Is it possible to make 
the emergency cycle 
go through totally 
invisibly and dis-
ceetly? There should 
be no lights, no 
sounds, nothing to 
indicate I am calling 
for help...  

For discreet emergency cycle, make sure 
that the following settings are all turned off 
(i.e. check boxes are left blank): 
Play  tones, see PAGE 22. 
Display notifications, see PAGE 22. 
Vibrate, see PAGE 22. 
The only sign of the ongoing discreet 
emergency cycle is the handset turned 
black. See PAGE 34.
Have you transferred settings into the 
device? See PAGE 11 . 
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TRACKING IN EMERGENCY MODE 

Question/Problem Answer/Checkpoints

I am going to a sum-
merhouse over the 
weekend. I want to be 
able to make an emer-
gency call just in case 
if something happens 
(e.g. snake bites me). 
However, I do not want 
to be tracked by any-
one at work, at least 
not without my knowl-
edge. How to  config-
ure the device?  

Remove all work numbers from the list of 
authorised numbers. See PAGE 25. 
Remove service center number if it is a 
work number. See PAGE 25.

Enable Authorization setting. See 
PAGE 25.
To be able to use emergency cycle you 
must have some emergency numbers in 
Reporting and calling list. They can be 
even work numbers. See PAGE 20.  
To enable tracking in emergency situation 
to continue after cycle is put through, 
ensure that emergency mode manual ter-
mination is turned on. See PAGE 23.  

A while ago I pressed 
the BeneGuard button 
in order to start the 
emergency cycle and 
now there is a plain tri-
angle in the middle of 
the display. What is 
happening right now?

The device is still in emergency mode: In the 
background the device may send its position 
in sequence to the requesting number. When 
the emergency mode is configured for man-
ual termination, emergency numbers can 
keep on tracking the device after emergency 
cycle is put through - but  you can be tracked 
only after you have started emergency cycle 
until you end the emergency mode manually.  
You can end the mode (i.e. stop being 
tracked) at any time by pressing c. 
Using manual termination in emergency 
mode increases your safety. But if you do not 
want to use it, turn it off. See PAGE 23 
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PART G: IMPORTANT SAFETY 
INFORMATION

CARE AND MAINTENANCE
NOTE: The instructions below apply to the device, its acces-

sories, batteries in use as well as batteries taken out of use. 

•Dust and dirt may damage the moving parts of the device.

Do not use or keep the device in dusty or dirty surround-

ings. 

•Do not open the device or battery by yourself or pierce

holes in it.

•Rough handling may break the circuitry inside the device.

Do not drop, knock, twist or shake the device or its bat-

tery.

•Keep the device dry. Liquids contain minerals which could

corrode electronic circuits. If the device gets wet, turn it

off  and dry the device and the battery immediately. Put

the device into an upright position and let it dry. It is rec-

ommended that a dealer or service personnel check that

the device functions properly.

•Even though the device is splashproof, do not wet the

device unnecessarily  or immerse it in water. 

•Protect the device from heat. High temperatures may

shorten the life of the electronical devices, melt or warp

plastics and damage batteries. Do not warm up the device

or battery or use it near fire. 

•Do not short-circuit the battery. Exposing the metal strips

of the battery to a close contact with a metallic object,

such as a coin, a clip or a set of keys can cause accidental

short-circuiting and damage the battery.

•Charge and recharge the battery only with the charger

specified in this manual/Quick Guide. Use the battery only

for the purpose it is intended.

•Clean the device with a soft cloth, dampened slightly with

mild soapy water. Do not clean the device with harsh

chemicals, solvents or other corrosive substances. 

•Only allow service personnel authorised by the dealer to

service the device. 
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SAFETY AND PRECAUTIONS

Telematics protocol
MPTP (Mobile Phone Telematic Protocol) allows, among

other things, tracking of the device over the SMS communi-

cation. 

Automatically sent telematics messages are only allowed to

authorised numbers configured in the device. Such num-

bers can be, e.g. emergency and service center numbers. 

Position of the device is retrieved by the GPS, or by the net-

work parameters - the latter is a network-dependent service. 

The carrier for telematics messages is an SMS-message. De-

liveries of all messages is fully handled by and in the respon-

sibility of the GSM network operator and services can vary

substantially. 

The charge of a protocol message is determined  on the con-

tract by the service provider. 

GPS 
The Global Positioning System (GPS) is operated by the gov-

ernment of the United States, which is solely responsible for

its accuracy and maintenance. The system is subject to

changes that could affect the accuracy and performance of

all GPS equipment. 

Emergency calls
The device is an aid and should never be relied upon as an

only emergency device. Its  functionality is dependent on

GSM network and GPS satellites which may not be available

all the time. 

To make emergency calls, the device must be turned on and

located in an area with adequate GSM network signal

strength. Making BeneGuard emergency call also requires

GPS satellite coverage and a valid SIM-card.  

Emergency calls may not be possible on all GSM phone net-

works or when certain network services or phone features

are in use. In unclear cases, consult the network operator.      
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General
•Traffic: Strictly adhere to all eventual European and

national legislation and also honour other eventual safety

recommendations when using the device while driving a

vehicle. Place the device in its holder, do not leave it on

the passenger seat or some other place where it can break

loose in a collision or a sudden stop. When receiving a

call in an awkward driving situation, you must always put

safety before other priorities and courtesy. If you feel

uncomfortable about using a device while driving, you

should not use it. 

•Vehicles with air bags: An air bag inflates with great

force. Do not place objects, including either installed or

portable wireless devices, in the area over the air bag or in

the air bag deployment area. 

•External alert: The use of the alert device to operate a

vehicle´s lights or horn on public roads is not permitted.  

•Children: Keep the device and its accessories away from

small children to avoid causing injury to themselves or

others. Damage to the device or its accessories is also thus

avoided.

•Power supply: This equipment is intended for use with

the specified power supplies listed in the Quick Guide/

Operating Instructions. Any other usage will invalidate any

approval given to this apparatus and may be dangerous.   

•Other accessories: Any other accessories used should

also be approved by the device manufacturer. Check the

compatibility of new power supply units and other acces-

sories at the dealer or manufacturer.  

•Connections: All installations, connections and service

regarding the device, its power supply and accessories

should be approved by the device manufacturer. Use of

any unauthorized accessories, modifications or attach-

ments may be dangerous and voids the device warranty if

said accessories cause damage or a defect to the device.

•Magnetic fields: The device contains small magnetic

components. Even though the magnetic fields of the com-

ponents are weak, they might damage magnetic cards,

such as bank and credit cards. We recommend that you

would keep the device away from magnetic cards. 

•Storing positions: Position information is stored cor-

rectly in the device when the GPS is turned off (from the

GPS menu) or powered off (by pressing the upmost side

key). To prevent the memory from becoming corrupted,

never power off  the device by removing the battery.    
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Radio frequency (RF) energy
•Aircrafts: Turn your device off before boarding any air-

craft and do not use the device while in the air. Besides

being illegal, the use of a device in an aircraft may endan-

ger the operation of the aircraft or disrupt the mobile net-

work. Failure to comply with this instruction may lead to

suspension or denial of mobile phone services, and possi-

bly even legal action.

•Hospitals: Turn the device off before entering hospitals

or other health care facilities where medical electronic

equipment may be in use. Medical equipment can be

extremely sensitive to radio frequency interference. Only

use the device with permission and under the instruction

of hospital staff.

•Medical devices: Remember that any personal medical

devices (such as hearing aids or pacemakers) may be

affected by RF energy if they are not adequately shielded.

Consult the manufacturer or vendor of the equipment to

determine the proper shielding.

•Posted facilities and country-specific regulations:

Power off the device in any facility where posted notices

require to turn off mobile phones. Also follow all the

country-specific regulations applicable to where the

device is used. 

•Potentially explosive atmospheres: Turn off the device

at refuelling points, e.g. gas stations. Also observe restric-

tions on the use of radio equipment in fuel depots, chem-

ical plants or where blasting operations are in progress

because remote control RF devices are often used to set

off explosives. Do not store or carry flammable liquids,

gases or explosive materials in the same compartment as

the device, its parts or accessories. 

•Other electronical equipment: Using the device may

cause interference with a vehicle's electronic equipment if

it is not adequately shielded. Consult the manufacturer or

the vehicle seller to determine the proper shielding.

•Computers: Remember that using the device close to a

computer may cause interference. When using your

device near such equipment keep a distance of about one

meter.

•Body parts: When the device is in operation do not touch

the antenna with eyes, mouth or bare skin to guarantee

proper function.
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BENEFON WARRANTY
A warranty certificate with the date of purchase is enclosed

in the delivery. Service operations are carried out for free at

Benefon during the warranty period. 

BENEFON warrants its products to be free of defects in ma-

terial or workmanship when leaving the factory. If a defect

is found during the given warranty period, the customer

should without delay and latest within the given warranty

period return the product, together with the warranty certif-

icate and the purchase receipt, to the BENEFON dealer who

sold the product or, if this is not feasible, to any other au-

thorised BENEFON sales or service facility.

A defective product with valid BENEFON warranty will be

made good by having it repaired or replaced, as seen appro-

priate by BENEFON in each case. Repair or replacement of

the product does not extend the original  warranty period.

The warranty does not cover defects caused by using the

product with peripheral equipment or accessories not sup-

plied or approved by BENEFON, or defects caused by repairs

or modifications carried out by parties not authorised by

BENEFON. 

Neither does the warranty cover defects directly attributable

to abuse, misuse or accident of any kind nor changes in con-

sumable parts (e.g .batteries) attributable to normal wear

and tear.

The warranty is void if the manufacturing identity data at-

tached to the product have been altered, erased or rendered

unidentifiable.

BENEFON assumes strictly no responsibility for special, in-

cidental, punitive or consequential damages, or loss of use.

 

  

The warranty period of this BENEFON product expires in

................................................................................................

BENEFON dealer who sold the product...............................

................................................................................................

IMEI code/serial number......................................................

P.O. Box 84, 

FIN-24101 Salo, Finland 

Fax int. +358 2 733 2633
54 BENEFON WARRANTY



APPENDIX
APPENDIX

LIST OF MPTP COMMANDS
AVAILABLE FOR BENEFON SERAPH

For more information on MPTP messages, please see the

separate document on MPTP commands, located at the Web
site: www.benefon.com. 

LOCATION MESSAGES

WAYPOINT MESSAGES

ASSISTANCE MESSAGES

TRACKING MESSAGES

EMERGENCY MESSAGES

MPTP TERMINAL SETTINGS MESSAGES

STATUS MESSAGES

Command Short description

LOC Location request/report

NMR Network measurement report

GNR GPS and network report

HIS History messages

Command Short description

WPC Create waypoints

WPT Waypoint activation/deactivation/deletion

WPA Arrival/departure to waypoint (Alarm message)

Command Short description

ASS Assistance call (Information call/Position report)

Command Short description

TRC Easy version of tracking

TRS Tracking in seconds (Short intervals)

STO Stop trigger: This will stop easy tracking 
(TRC/TRS)

TRG Complex version of tracking

Command Short description

EGN Emergency message

Command Short description

CNF Configuration (phone numbers, GPS mode etc.)

PSR Phone settings request

PWD Password (Encryption keys)

Command Short description

STA Status information (Power msgs/notifications)

SIR SW-versions and IMEI-number request/reply

INF Information message (Power failures)
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